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Excel Databases

Database Issues

Database Concepts

· A field XE "field"  is a category of the database, such as Name, Address, city, etc. The top row of the database contains field names. Fields help you define divisions of the database, and how you can search for records.

· A record XE "record"  is a complete group of information about one entity. Typically, each row of data is a record.

· An item is one individual piece of a record XE "record" , a label XE "label"  or value occupying a single cell that makes up part of a record.

Rules XE "Rules"  

· The field XE "field" -name headings must have unique names.

· Field name headings cannot be dates, numbers, blanks, or non-text formulas.

Database Terminology

· External Database XE "External Database" : A collection of data that is stored in one or more files (not Excel files.)

· Field: An element of a record XE "record"  that corresponds to a column.

· ODBC XE "ODBC" : Open Database Connectivity, a standard developed by Microsoft that uses drivers to access database files in different formats. MS Query XE "Query"  comes with drivers for Access XE "Access" , dBASE XE "dBASE" , FoxPro XE "FoxPro" , Paradox XE "Paradox" , SQL XE "SQL"  Server XE "SQL Server" , Excel workbooks, and ASCII XE "ASCII"  text files. ODBC drivers for other databases are available from Microsoft and third party providers.

· Query XE "Query" : To search a database for records that meet specific criteria. This term is also used as a noun; you can write a query, for example.

· Record XE "Record" : In a database table, a single element that corresponds to a row.

· Refresh XE "Refresh" : To rerun a query to get the latest data. This is applicable when the database contains information that is subject to change, as in a multi-user environment.

· Relational database XE "Relational database" : A database that is stored in more than one table or file. The tables are connected by having one or more common fields (sometimes called the key field XE "field" .)

· Result set: The data that is returned by a query, usually a subset of the original database. Query XE "Query"  returns the result set to your Excel workbook or to a pivot table.

· SQL XE "SQL" : Structured Query XE "Query"  Language (usually pronounced sequel). MS Query uses SQL to query data that is stored in ODBC XE "ODBC"  databases.

· Table: A record XE "record" - and field XE "field" -oriented collection of data. A database consists of one or more tables.

Creating a Database in Excel

1. Enter a row of labels. These labels are field XE "field"  names.

2. Go to Format to Columns to AutoFit Selection XE "AutoFit Selection"  to make the columns as wide as they need to be.

Data Entry

Tips

· To enter a number that’s really text (like a ZIP code), type an apostrophe first. For example, ‘07623 would keep the leading zero, would left justify, and can’t be calculated or you can format the cells or the whole column.

· You can use AutoFill XE "AutoFill"  to enter data if it’s part of an AutoFill list or you want the same data in a series of cells.

· To repeat an entry from the cell directly above the active cell, do one of these:

· Select the cell to be filled, press control and ‘ (apostrophe) and press Enter.

· Select the cell containing the entry you want to repeat and drag the AutoFill XE "AutoFill"  handle.

· Select the cell containing the entry you want to repeat and the new cell(s) to be filled, and press Control and D.

· To enter identical entries in several cells at the same time, use Control and Enter:

1. Select all the cells in which you want to enter data.

2. Type the entry.

3. Press Control and Enter.

· To quickly enter an item in a list of repeated items (such as an expenses list), use AutoComplete XE "AutoComplete" :

1. Begin typing an entry at the bottom of the list.

2. If the characters you type are identical to an existing entry in the list, the rest of the entry is filled in for you.

3. If your entry is different, keep typing and the AutoComplete XE "AutoComplete"  entry will disappear.

Using Data Forms XE "Forms" 
You can insert records by moving to the end of the database and entering the data, but if you do, the formatting attributes aren’t applied to the new entries, nor are formulas copied into new cell locations. Excel deals with this by providing Data Forms XE "Forms" . A Data form allows you to add, delete, and search for specific records. The form also applies formatting and inserts formulas for calculated fields. 

Rules XE "Rules" 
Note: Data validation works capriciously when using forms.

1. The cursor must be in a cell in the database.

2. Calculated fields, like the Profit field XE "field"  in the following example, can’t be changed in forms.
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Click the New button to add a database record XE "record" . When you press Enter, Excel adds the new record at the end of the database. When you press Close, it closes the data entry form.

4. A data form can have a maximum of 32 fields. The content of editable fields appear s in text boxes. Calculated values and protected fields also appear on the data form, but aren’t editable.

5. If you want to delete the record XE "record"  which appear s in the form, click Delete.

6. To search for records that match some search criteria, click Criteria and enter the desired search criteria, then click Find Next or Find Prev to locate the next matching record XE "record" . To clear all criteria and return to the last record displayed, click Criteria, click Clear, then click Form.

7. Changes are permanently saved when you press Enter, click New, click Close, or move to another record XE "record"  using the scroll box. Before you do any of these things you can click Restore.

To Enter Data:

1. Be sure your table has column headings and at least one row of data already entered.

2. Click a cell in the database. 

3. Click Data in the Menu Bar.

4. Click Form…

5. Click New to enter a new record XE "record" .

6. Type a value and press Tab. (Shift Tab moves you back to the previous record XE "record" .

7. Continue until done with the record XE "record"  and press Enter to enter it.

8. Continue to add records.

9. Click Close to finish with data entry. New records are added at the end of the table.

Naming a Range XE "Naming a Range" 

 XE "Range" 
You can name a range of cells. Range XE "Range"  names can contain only letter, numbers, periods, and underscores. No spaces are allowed and capital/lower cases are the same. Also the name can’t start with a number or a period, and the name can’t look like a cell name (i.e., A14 or IV121).

To name a range, do this:

1. Select the range.

2. Click in the Name box on the formula bar. Excel highlights the current name in the box, inviting you to change it.. type the new name.

3. To go to a named range, click any cell. 

4. Click the down-arrow to the right of the name box and choose the range.

Find XE "Find" 
You can use Excel’s find feature (similar to Word’s, but not as powerful), to scan the spreadsheet to find words and characters.

Do this:

1. Click Edit, then Find.

2. In the Find what box, type the characters you’re looking for. You can also specify Match case or Find entire cells. Note: you can use two types of Wildcards. ? stands for any single character, and * stands for any string of characters.

3. Click Find Next.
4. You can limit Excel’s searching to Formulas, Values, or Comments if you want.

Note: Comments refers to comments you add to your spreadsheet.

Values, in this context, means whatever you normally see on the screen, whether it’s text you’ve typed, a number that you’ve typed, or a number that was calculated using a formula.

Formulas, in the context, means anything you typed into the cell, whether it was truly a formula or any kind of data. In other words, whatever appears in the formula bar.

5. You can also your Replace by clicking on it in the find dialog box. However, it leaves formulas alone, and will only replace stuff you typed in.

Go To XE "Go To" 
Click Edit, then Go To and you can type in a cell address or a named region. It will keep a list of all locations you’ve jumped to recently, whether you used Go To or the Name box.

A more powerful feature is that you can click Special in Go to and choose specific types of entries.

Multiple Sheets XE "Multiple Sheets" 
Multiple sheet formulas

1. Click New on the toolbar.

2. Type the numbers 1, 2, 3, and 4 in Sheet 1’s A1:B2 range.

3. Click the Sheet 2 tab, near the bottom of the screen, and type numbers 5, 6, 7, and 8 in this sheet’s A1:B2 range.

4. Click the Sheet 3 tab. This will be a Total sheet. Right click to rename the sheet.

5. Click cell A1. Type =
6. Click Sheet 1 tab and click cell A1. (The formula bar now says =Sheet1!A1.)

7. Type + 

8. Click sheet2 and then click A1.

9. Press Enter.

10. You’ll now be on Sheet 3, where you start4ed, and the number in A1 will be the sum of the A1 cells on both Sheet 1 and 2.

What-if Scenarios XE "What-if Scenarios" 
Create a Scenario

1. Open a spreadsheet.

2. Select the cells you will want to change in your scenario. They don’t have to be contiguous, or touching: Use the Control key to select non-contiguous cells.

3. Click Tools, Scenario.

4. Create a baseline Scenario: click the Add button. Give the scenario a name, such as Baseline. Click OK.

5. Tell Excel what values the scenario will use for the chosen cells. Since this is a baseline scenario, you won’t change anything. Click OK.

6. Excel will go back to the Scenario Manager.

7. Click Add in the Scenario Manager to add another scenario, such as 4th quarter goes to the dogs. Put in the changed cells and the scenario name. Click OK.

Data Validation XE "Data Validation" 
Setting it Up

1. Select the column heading where you want to validate the entries. 

2. On the Data menu, click Validation XE "Validation" . The Data Validation dialog box comes up:
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On the Settings tab, select a type of data in the Allow dropdown list. 

4. In the Data drop-down list (if it’s available), select any value-limiting criteria you want, such as “between” or “greater than.”

5. In the boxes that are displayed below the Data drop-down list, set criteria such as Minimum and Maximum allowable values. 

6. Allow and Data drop-down lists: will allow the data entry person to click a drop down list and select from the list you’ve set up. You need to set the list of possible values elsewhere on the worksheet.

7. To require an entry in the cell, clear the Ignore blank check box.

8. On the Input Message tab, type a title and message to be displayed when one of the validated cells is selected. If you don’t want a message to appear, clear the Show input message when cell is selected check box. 

9. On the Error XE "Error"  Alert tab, choose an icon, type a title, and type an error message that displays when invalid data is entered (if you don’t want a message but simply want invalid data entry refused, clear the Show error alert after invalid data is entered check box.)

10. Click OK.

11. Click a cell in the column you just chose, and you’ll see the tool tip you set up. Type an invalid entry, and you’ll get the error message you set up.

12. You can retry, or edit the contents of that cell, or you can click Cancel to delete the contents of the cell.

13. Invalid data already in the worksheet won’t show up unless you use the Auditing XE "Auditing"  tools.

Removing Data Validation XE "Validation" 
1. Select the column where data validation is in place.

2. On the Data menu, click Validation XE "Validation" .

3. Click the Clear All button.

4. To remove the same validation settings from all cells where they’re enforced, click the Settings tab, then click the Apply these changes to all other cells with the same settings check box.

5. Click OK.

Locating Validated Cells on a Worksheet

1. Click Edit>Go To.

2. Click Special.
3. In the Go To Special dialog box, click Data Validation XE "Validation"  and All.
4. Click OK. All cells with validation rules are highlighted.

Error XE "Error"  values

	This Error XE "Error" …
	Means this…
	To fix it…

	#####
	The column isn’t wide enough.
	Widen the column.

	#VALUE! XE "#VALUE!" 
	Wrong type of argument or operand (for example, calculating a cell with the value #N/A XE "#N/A" ).
	Check operands and arguments. Make sure references are valid.

	#DIV/)
	Formula is attempting to divide by zero
	Change the value or cell reference so that the formula doesn’t divide by zero.

	#NAME? XE "#NAME?" 
	Formula references an invalid or non-existent name.
	Check spelling.

	#N/A XE "#N/A" 
	No value is available or inappropriate arguments were used.
	Be sure the lookup table is sorted correctly.

	#REF!
	Excel can’t locate the referenced cell(s). for example, they might have been deleted.
	Click Undo immediately to restore references.

	#NUM!
	Incorrect use of a number or formula result is a number too large or too small to be displayed.
	Make sure arguments are correct.

	#NULL!
	References to intersection of two areas that do not intersect.
	Check for typing and reference errors.

	Circular
	A formula refers to itself, either directly or indirectly
	Click OK and look at the status bar to see which cell contains the circular reference.


Locating Errors in Formulas (above errors)

1. Right-click a toolbar and click Customize to display the Auditing XE "Auditing"  toolbar. In the Customize dialog box, on the toolbars tab, mark the Auditing check box and click Close.

2. Click the cell containing the error.

3. On the Auditing XE "Auditing"  toolbar, click the Trace Errors XE "Trace Errors"  button. Tracing arrows appear and guide you to possible sources of error. Blue trace lines show referenced cells, and red trace lines lead to the cell that caused the error value.

Find Cells In The Worksheet Which Contain Invalid Data XE "Invalid Data" 
If you’ve set up validation which that invalid data can be entered, or if you applied validation rules after entering data, you can locate cells that don’t meet the validation rules:

1. Make sure data validation has been set up for the cells you want to check. Or, you can go ahead and set up validation rules. (Note: Validation XE "Validation"  only finds a maximum of 255 cells that don’t meet validation rules.)

2. Right-click a toolbar and click Customize to display the Auditing XE "Auditing"  toolbar. In the Customize dialog box, on the Toolbars tab, check the Auditing check box and click Close.

3. Select the range you want to check for invalid data.

4. On the Auditing XE "Auditing"  toolbar, click the circle Invalid Data XE "Invalid Data"  button. All the cells containing data that doesn’t meet validation rules will be circled in red.

5. To remove the circles, click the Clear Validation XE "Validation"  Circles button.

Conditional Formatting XE "Conditional Formatting" 
Let’s say you want to highlight all expenses in a spreadsheet that are over $100. 

1. Create a small spreadsheet with an expenses field XE "field" , and several numbers over and under $100.

2. Select the column and click the Currency Style icon so that numbers in this column are in dollars and cents.
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Click Format, Conditional formatting. You’ll get the conditional formatting dialog box.

4. Choose the condition you want. If you only want one, set the formatting and click OK. 

5. Note: you can’t change the font, size, or super/subscript for a conditional flag.

6. In this case, notice that you not only flag all the numbers already there that are over 100, but Excel also highlights any new entries over 100. 

Separating a Single Column into Multiple Columns XE "Multiple Columns" 
You may have a situation where you want to divide the data from one cell into 2 cells. For instance, you might want to take data in a Name field XE "field"  and separate it into last name and first name. Do this:

1. Select the cells. Leave an empty column on the right of the column you’re “parsing,” or separating, so that the new column you’re going to create has somewhere to be pasted.

2. Open Data and select Text to columns. You’ll get the Text to Columns Wizard.

3. Make sure Delimited is selected and click Next.

4. Choose a delimiter. (In this example, probably it’s a space.) Click Next.

5. Set data formats if you need to. Click Finish.

Importing XE "Importing"  Data from Another Source

Importing XE "Importing"  a Text file XE "Text file" 
The file type which can be used by just about every Windows application is a Text file XE "Text file"  (.txt.) Typically, you’ll get a file on disk from someone where the data appears in rows delimited by a comma or a space or a tab, as below: 

LastName
FirstName 
MI
Salary
Hire date
No. of Children
Age

Smith
tom
J.
"25,000"
4/20/87
4
42

Jones
Mary
L.
"30,000"
1/19/97
0
25

Johnson
Jerry
M.
"43,000"
5/20/93
2
37

Jackson
Mathilda
P.
"29,000"
6/30/98
3
33

Thomspon
Jane
L.
"45,000"
1/4/94
2
35

Mason
George
J.
"42,000"
2/2/94
1
25

Taylor
Maureen
L.
"43,000"
3/25/94
2
33

To import such a file, do this:

1. First, go to Notepad XE "Notepad"  and look at your data so you can see what it looks like.

2. Open Excel.

3. On the Standard toolbar or the File menu, click Open.

4. Go to the drive where the data is and click All files (*.*) in the Files of Type box.

5. Double-click the name of the text file. The Text Import Wizard XE "Text Import Wizard"  will start.
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In Step 1, be sure the Delimited option button is selected and then click Next.

7. In Step 2, mark the Tab check box. If the data isn’t in neat, delimited columns, try other delimiters. Then click Next. 

8. In Step 3, you can set preliminary data formatting. Click the heading in the Data preview window for the column you want to format. If the column contains numbers, leave the formatting in the Column data format section set to General. If the column contains dates, select Date. 

9. Click finish.

10. When you save the workbook, the Save As dialog box appears and will try to save the data as a text file. Be sure to save the file as a workbook!
Sorting XE "Sorting"  Lists

· In Excel, the words list and table usually refer to the same thing: a block of data pertaining to a single subject, in which each column, or field XE "field" , contains the same kind of data.

· If you want to sort a single column in a table without sorting the attached data along with the column, select all the cells in the table column before sorting and press the A(Z or the Z(A toolbar button. Only that column is sorted, and the other columns are unchanged.

· Normally you’ll want to sort by one field XE "field"  and you’ll want the data in the other columns to follow along. 

· When you sort a list, you arrange a specific column, or field XE "field" , in the list in an ascending or descending order. The field you sort on is known as a sort key. The data in the other columns is also sorted along with the sort key data, so that the data in any row (or record XE "record" ) remains the same.

· Data in cells separated from the list by a blank row or column is not included in the sort. Thus you could have two lists on a worksheet and sort them independently of one another, as long as a blank row or column separates them.

Sort Rules XE "Sort Rules" 

 XE "Rules" 
In Excel, cells can contain different types of information, which can be confusing when you’re trying to sort. For an ascending sort, the information appears in the following order.

· Values: Numbers are sorted from smallest negative to largest positive. Dates XE "Dates"  and times are treated as values. In all cases, the sorting is done using the actual values, not their formatted appearance.

· Text: In alphabetical order, as follows: 0123456789(space)!”#$%&’()*+,-./:;<>?@[\]^_`{|}~ABCDEFGHIJKLMNOPQRSTUVWXYZ.

· By default, sorting is not case sensitive. You can change this, however, in the Sort Options dialog box.

· Logical values: False comes before True.

· Error XE "Error"  Values: Error values (such as #VALUE! XE "#VALUE!"  and #NA) appear in their original order and are not sorted by error types.

· Blank cells: Blank cells always appear last.

· Sorting XE "Sorting"  in descending order reverses this sequence – except that blank cells are still sorted last.

Sorting XE "Sorting"  Lists by One Column

Sort a List by a single key 

1. [image: image7.png]%) File Edit View Insert Format Tools Data Window Help

5o ® B 1000+ | B[ & | Prompt
-0 LD A
a1 | =] Vendor
D E G H 1 J K L M
1| category Amount Vendor BTN
2 |office supplies $21.50
3 |software $189.99
4 |books/publications $149.98 7]
5 |office supplies $15.98
6 |software $140.00 e
7_|office supplies $15.98 E o
8 |books/publications $199.00 Reference L
9 |office supplies $15.99 | 3 erowse.
10 |software $29.99 pr—
11 |books/publications $29.00 e it
12 |office supplies $35.18
13 |office supplies $15.98 &
14 |software $35.76
15 |software $189.99 Use labels in
16 | books/publications $58.00 W Top row
17 | office supplies $2150 F Left column I Creats links to source data
18 |software $45.55
19 |books/publications $49.64
20 |office supplies $75.66
21 |software $72.68
22 |office supplies $15.98
23 | books/publications $28.85
24 | office sipplies. $62 85
i€« > [ i}, Sheet! { Sheez / Sheetd Ll
Draw ~ AutoShapes - - L-A-
Enter NUM

jg@Start| | gyMicrosoft Word _[[SZMicrosoft Exce...

A mg  12:55 PM



Click in any cell in the column you want to sort by.

2. On the toolbar, click a sort button:

To sort in ascending order (1-10, a-z), click Sort Ascending.

To sort in descending order (10-1 or z-a), click Sort Descending.

Sorting XE "Sorting"  Lists by Two or More Columns

1. Click anywhere in the Table.

2. On the Data Menu, click Sort. You’ll get the Sort dialog box shown here.
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In the Sort by box, click the down arrow. Click the top-level sort key (Salary, in this example.)

4. Choose Ascending or Descending order.

5. In the first Then by box, choose the second-level sort key (such as last name) and a sort order. If you want other options, choose the Options button.

6. Click OK.

7. You’ll get this dialog box.
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Note: If you want to sort by four or more fields, you must sort by the major, overall biggest key last. First sort on the detailed keys and then sort using the sort dialog box on the major sort key(s).

Sorting XE "Sorting"  by a Custom List XE "Custom List" 
If you’ve created a Custom Lists table, you can sort by that list.  For instance, if you wanted to sort by age, you could do that with the example above if you had previously created a custom list with the names of the people and their ages. You would click Data, then Sort, then Custom, and you’d find the list by pressing the Down arrow in the First key sort order drop-down list box.

Filtering XE "Filtering"  Lists
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If you have a large table of data and you want to focus on particular records, or rows, you can filter the table to show only those records and hide the rest. You can also use filters to extract specific records and paste them onto another worksheet or a Word or PowerPoint document. The easiest way to filter a list is to use AutoFilter XE "AutoFilter" . You can filter a list by looking for a specific entry in a single field XE "field"  or by looking for multiple criteria XE "multiple criteria" . 

Filter a list on a single criteria

Suppose you want to do some sorting or other work with the people on the list at the right who are in California. You don’t want to change anything permanently or make another spreadsheet; you only want to filter out the records of people from all states other than CA.

1. Click on any cell in the table.

2. Click Data, then Filter, then AutoFilter XE "AutoFilter" . Small gray filter arrows appear at the top of every column in the table. 

3. Click a filter arrow in the field XE "field"  in which you want to set filter criteria. In this case, it is State.

4. Click the criteria on which you want to filter (such as CA.)

5. Records with the criteria you choose are displayed, while all others are hidden. The filter arrow is now blue, to help you remember where you set criteria.

6. To keep AutoFilter XE "AutoFilter"  on but remove the criteria, click the filter arrow and click All.

7. To remove the filter and display all records, open the Data menu, point to Filter, and click AutoFilter XE "AutoFilter"  to turn it off.

Rules XE "Rules"  for Filtering XE "Filtering"  Data

· The database must have column labels (field XE "field"  name headings.)

· Clicking the All option in any drop-down AutoFilter XE "AutoFilter"  list displays all the database records.

· Clicking the Custom… option in any drop-down AutoFilter XE "AutoFilter"  list displays the Custom AutoFilter dialog box. You can use this dialog box to specify and/or criteria for viewing records.

Filter a list on multiple criteria XE "multiple criteria" 
Here are some ways to narrow a filter and make it even more specific:

· Filter on two different fields.

· Filter on two criteria in the same field XE "field" .

· Filter on a criteria range.

· Filter on the highest or lowest numbers in a number field XE "field" .

2 Different Fields:

1. Click the table. On the Data menu, point to Filter and click AutoFilter XE "AutoFilter" .

2. Click the filter arrow in the first field XE "field"  and click the criteria you want.

3. Click the filter arrow in the second field XE "field"  and click the criteria you want.

Two criteria in the same field XE "field" :

1. Click the table. On the Data menu, point to Filter and then click AutoFilter XE "AutoFilter" . If AutoFilter is already turned on, remove all other AutoFilter criteria. (All AutoFilter arrows should be black.)

2. Click the filter arrow in the field XE "field"  and then click Custom…
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The Custom AutoFilter XE "AutoFilter"  dialog box appears:

4. In the top left box, select a comparison operator from the list (now showing equals).

5. In the top right box, select a value from the field XE "field" .

6. Click the And or Or button. (And means all criteria must be met; Or means only one criteria must be met.

7. In the lower boxes, select a comparison operator and field XE "field"  value.

8. Click OK.

Filtering XE "Filtering"  on a Criteria range

You might want to see a filtered list of all records for which salary is greater than or equal to $20,000 and less than or equal to $40,000. Do this:

1. Click the table. On the Data menu, click Filter and AutoFilter XE "AutoFilter" . If AutoFilter is already turned on, make sure all other AutoFilter criteria are removed.
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Click the filter arrow in the Salary field XE "field"  and then click (Custom). The Custom AutoFilter XE "AutoFilter"  dialog box appears:

3. Choose the first level comparison operator and value, then choose And or Or, as above, then choose the second comparison operator and field XE "field"  value.

4. Click OK.

Note: this operation works well with dates.

Filtering XE "Filtering"  on the highest and lowest numbers in a number field XE "field" .
Say you want a list of the three highest salaries. Do this:

1. Click in the table; click Data in the menu bar; click Filter, click AutoFilter XE "AutoFilter" .

2. If AutoFilter XE "AutoFilter"  is already turned on, be sure all other AutoFilter criteria are removed.
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Click the filter arrow in a number field XE "field" , such as salary.

4. Click Top 10. You’ll get the dialog box below:

5. Chose Top or Bottom, the number you want, and either Percent or Items.

6. Click OK.

Calculating XE "Calculating"  Filtered Records

Fast, Temporary Calculations
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For quick, temporary calculation of filter records, filter the list, select the cells you want to use in your calculation, and right-click the status bar at the bottom of the screen to get the AutoCalculate XE "AutoCalculate"  box as seen on the right. Click on the type of autocalculation you want and on the status bar. AutoCalculate only calculates visible cells. 

The results of the autocalculation appear on the status bar, under the AutoCalculation box at the right.

AutoSUBTOTAL XE "AutoSUBTOTAL" 
If you use the AutoSum button to create a SUM formula when the table is filtered, a SUBTOTAL formula is created instead of a SUM formula, but the new subtotal function calculates a sum. If you want the SUBTOTAL function to calculate an average instead of a sum, you need to change the calculation argument in the SUBTOTAL function.
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Deleting XE "Deleting"  Records

Remember that you cannot undo the action once you delete a database record XE "record" . Your only recourse would be to close the file without saving changes.

1. Open a file

2. Select Data, then Form…

3. Click Criteria to open the criteria dialog box (right)

4. Click in one of the fields and type a value.

5. Click Find Next.

6. Click Delete.

7. Click OK. The next record XE "record"  matching the criteria displays; click Delete. The dialog box clears when all the matching records have been deleted.

8. Click Close.

Summarizing XE "Summarizing"  Details 

If you have a long list of data, summarizing the data with subtotals makes it more meaningful. There are three ways to summarize all the subcategories in a table at once: consolidation, subtotaling, and PivotTables XE "PivotTables" .

Consolidation was Excel’s early method of summarizing details with subtotals, and it’s still available. It’s quick and easy, but not very flexible. The result is a list of subtotals with no underlying detail data available.

Subtotaling XE "Subtotaling"  goes one step further. It creates subtotals for each subcategory in the table, while retaining the detail items in the table and enabling you to show or hide whatever subcategory details you want.

PivotTables XE "PivotTables"  are much more complex, flexible, and useful.

Consolidating XE "Consolidating"  Worksheets Using Data ( Consolidate

You can consolidate worksheets by position, if the worksheets are laid out identically, or by category, if they have row and column labels. 

Consolidate and Sum a List

This will allow you to sum one list by categories.

1. Select a destination area, where the consolidated list will be pasted. It could be on the same worksheet, another worksheet in the same workbook, or a different workbook.

2. At the top of the destination area, type or copy the headings of the label XE "label"  and number columns that will be used in the consolidation. Select the destination area column labels.

3. Select the destination area column labels.

4. On the Data menu, click Consolidate. You’ll get the screen below.
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5. Select a function in the Function drop-down list box (Sum, in this case.)

6. Click in the Reference box and type the cell range you want to consolidate. In this case, you wouldn’t include the Date column, because Excel is looking for subcategory labels in the left column of the source range. You can type a range, type the name of a range, if you’ve named it, or select a range. After you add a Reference, click Add. Add more ranges if necessary.

7. Click the Top Row and Left column check boxes so Excel will look for labels in the source range(s).

8. Click OK. You’ll get the screen below:
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Note: If you name a range of cells Consolidate_Area, you don’t need to select it before you update the consolidation. Consolidate_Area is a name that has special meaning to Excel.

· Functions: Sum, Count, Avg, Max, Min, product, count Numbs, StdDev (standard deviation), StdDevp (population standard deviation), Var (variance), or Varp (population variance).

· All references is a list box that contains the list of reference you’ve added.

· Use labels in: these check boxes tell Excel to examine the labels in the top row, the left column, or both, to perform the consolidation. You would use these options if you’re consolidating by category.

· Create links to source data: this option, when selected, creates an outline in the destination worksheet that consists of external references to the destination cells. It also includes summary formulas in the outline. If this option isn’t selected, the consolidation won’t use formulas.

· Browse: this button displays a dialog box that lets you select a workbook to open. It inserts the filename in the Reference box, but you have to supply the range reference.

· Add: this button adds the reference in the Reference box to the All References list.

· Delete: this button deletes the selected reference from the All References list.

You can consolidate more than one worksheet into one. You can do it by position, if the worksheets are laid out identically, or by category, if they have row and column labels. 

1. Open the files you want to consolidate into one.

2. Create a new file to put your consolidated file.

3. Select Data in the Menu Bar, then Consolidate. You’ll see the Consolidate dialog box described above. Select the type of consolidation you want. Enter the Reference for the first worksheet to be consolidated. If the workbook is open, you can point to the reference. If not, click on the Browse button to locate the file. The reference must include a cell range, such as A1:D100. If the range is larger than the actual range to be consolidated, new rows added to the source file will update the consolidated file as well. When the reference is correct, click Add to add it to the All References list.

4. Add the reference for the second worksheet. Click Add. Continue if you have more.

5. If the worksheets aren’t laid out the same, select the Left column and Top row check boxes. This causes Excel to match the data by using the labels.

6. Select the Create Links to source data check box. This will create an outline with external references.

7. If the worksheets aren’t laid out the same, select the Left column and Top row check boxes.

8. Click OK to begin the consolidation. 

Tips:

· If you’re using labels, make sure entries are identical. In other words, make sure there are no misspelled Vendor or Category entries. Accuracy is essential to filtering, sorting, consolidating, or subtotaling tables.

· Name the source ranges and type the range names into the Consolidate dialog box. (To name a range of cells, simply select it and type a name into the Name Box above the cells and on the left of the Formula Bar.)

Updating XE "Updating"  a Consolidation

After you set up a consolidation, the settings are retained in the destination worksheet, and you can run the consolidation again to update it with changed source data.

Subtotaling XE "Subtotaling"  a Table

· A subtotaled worksheet retains detail data

· Subtotals and outlining are added to the table so that you can show or hide the details with a click of a button.

· Subtotaling XE "Subtotaling"  includes several levels of label XE "label"  columns as well as number columns.

· Data must be sorted before you subtotal it.

1. [image: image18.png]ivotTable Options

Narme:

Format options
W Grand totals for colurmns
W Grand totals for rows
W autoFormat table
I™ Subtotal hidden page iterns
I™ terge labels

I preserve formatting

Data aptians

page layouts |0own, Then Over

Eields per colurmn

I™ For error yalues, show!

W For empty cels, shaw

Data source options
¥ Save data with table layout
W Enable drildown
I™ Refresh on open

External data options
W save password
I~ Background query
I~ Optimize memory




Arrange your table so that the columns are logically organized, and sort the columns in the order you want to apply subtotals. 

2. To remove columns from view without removing them from the table, hide them: Select the columns, right-click them, and click Hide.

3. Click a cell in the table.

4. On the Data menu, click Subtotals.

5. In the At each change in box, select the first category to which you want to add subtotals.

6. In the Use function box, select a function. Sum is most common, but these functions are available: Sum, Count, Avg, Max, Min, product, count Numbs, StdDev (standard deviation), StdDevp (population standard deviation), Var (variance), or Varp (population variance).

7. In the Add subtotal to list box, mark the check boxes for number fields you want subtotaled. Clear check boxes for the fields you don’t. Only numerical fields should be included, because they’re the only fields that can be calculated.

8. Click OK.
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Here’s your subtotaled list. If you want to add another level of subtotals, you can Click Data, then Subtotals to do so. Clear the Replace current subtotals check box. Click OK.

Remove Subtotaling XE "Subtotaling" 
1. Click a cell in the table.

2. On the Data menu, click Subtotals.

3. Click Remove All.

Outlining XE "Outlining"  a Table Manually

You can outline a table without adding subtotals. An outlined table, like a subtotaled table, has Show and Hide buttons, but you decide what’s hidden or grouped. Reasons why you’d want to do this:

· You’ve already added subtotals to a table by writing your own formulas.

· You want to group data into categories so you can show and hide category details, without adding subtotals to the categories.

· You want to outline only part of a table without outlining the whole thing

1. First, sort your table and insert a blank row between groups, as shown.

2. Select adjacent rows that you want to combine into a single show-or-hide group. If there are totals in the table, don’t include them in the group or they’ll be hidden when you hide the group.
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On the Data menu, point to Group XE "Group"  and Outline, and click Group.

4. Outlining XE "Outlining"  is applied, along with the Hide button. When you press this button, the rows will be hidden and you’ll see the Show button.

Removing Manual Outlining XE "Outlining" 
1. Show all the detail rows for the groups where you want to remove outlining.

2. Select the rows you want to remove from the outline. (You can remove a few rows from the outline groups, but you can’t remove outlining from non-adjacent groups. You’d have to remove the outlining from one set of adjacent rows at a time.

3. Go to the Data menu, then Group XE "Group"  and Outline, and Clear Outline.

Using PivotTables XE "PivotTables" 
What is a PivotTable?

· Pivot tables let you look at the number in a variety of ways without changing your data.

· Usually when you think of spreadsheets, you think in two dimensions: quarterly sales by product, or inventory levels by location. There’s a series of “things” across the top, and a different series of “things” doing down the side.

But what if you want to change the things across the top or down the side? For instance, if you’re looking at quarterly sales by product, you might want to see quarterly sal4es by salesperson. In other words, you can create basic “reports” containing different subsets of information from the data base, with or without calculations, with all fields or only certain ones.

Tips

· The critical step of building a pivot table occurs when Excel displays the PivotTable Wizard. It’s at this point you must decide the position of the field XE "field"  buttons in the various areas making up the pivot table.

· Field buttons placed in the ROW area display the items as row labels in the pivot table.

· Field buttons placed in the COLUMN area display the items as column labels in the pivot table.

· The DATA area of the pivot table only calculates numerical items. You can’t calculate items containing text.

Why use pivot tables?

· You can summarize data from several sources: Excel lists, external databases, multiple worksheets, or other PivotTables XE "PivotTables" 
· You can pivot the table to change its orientation

· You can group items in a field XE "field"  (for example, group dates into months or quarters)

· You can change the calculation function for a field XE "field"  

· You can show details underlying a single summarized item

· You can format the PivotTable for a professional and reader-friendly presentation

Creating a PivotTable

1. Create this table:
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Click Next.
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Now you’re in Step 2. Click the button to the right of the Range XE "Range"  box, and you’ll get the little box above. You can select the range of cells by selecting them with your cursor in the database itself. Click on the box at the right of the box to return to the Wizard. Click Next. Now you get Step 3:
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Now you must specify how you want the fields in the database arranged in the pivot table. 

Which field XE "field"  goes where? In general, the columns in your spreadsheet come in two types: text columns, where you have repeating entries; and data columns, which usually (but not always) contain numbers

Start by dragging a text column to Row and all the rest to Column. Then drag all the data columns to Data. This may or may not work, and it ignores Page, but it’s a start: 
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Click Next. You’ll get Step 4 of 4:

You can either have your PivotTable in a new worksheet or paste it onto the same one. I put mine on a new worksheet, so I can delete the whole sheet if I hate it.
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You may also click the Options button to get these choices:

7. Click OK.

8. Click Finish to complete the table. Here is the one we chose for this example:
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Here are some possible conclusions you might draw from this pivot table: You can tell at glance that Apple sales in the fourth quarter beat the second quarter by a wide margin, and that a lot of that swing is due to Jim’s salesmanship in the fourth quarter. Grapes go way up in the second quarter, that’s largely to Lee’s efforts. Mangoes go way down in the first quarter, but Eileen somehow manages to keep her numbers up even then And Eileen does a good job of selling Oranges in the fourth quarter, but Lee does better.

Now we’ll “flip” this table over. The numbers won’t change, but the picture will.
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Click cell A2, where it says Product, and drag it just below the C column. Select cell C1, where it says Associate, and drag it to the right of A2. Now you’ll see this:

9. Note: sometimes it’s hard to drop category headings precisely where they belong. Click View, Toolbars, then choose Pivot Table Wizard. You’ll get the same screen you saw in Step 3 before, and you can move items around from there.

10. Pivot the table back to where it stood at first, by clicking on the PivotTable Wizard again and reversing the positions of Product and Associate. 

11. Collapse all the Associate entries. The easiest way to do that is to click Associate, in cell C2, and drag it on top of the A column heading. Or you can click the PivotTable Wizard icon and drag Associates to the box marked page. This collapses the salesperson information and looks like this:
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Continue to experiment with moving parts of the PivotTable to different locations. Remember that the PivotTable is still a spreadsheet, though, so you can format it however you want, use functions and formulas, create charts, etc.

Excel Tips

AutoComplete XE "AutoComplete"  and Pick From List XE "Pick From List" 
1. Begin typing an entry at the bottom of a list.

2. If the characters you type are identical to an existing entry in the list, the rest of the entry is filled in for you.

3. If your entry is different from the previous list entry, keep typing and the AutoComplete XE "AutoComplete"  entry will disappear.

4. If there are two or more similar entries in the list, right-click the cell where you want to enter data and click Pick From List XE "Pick From List" . Click the entry you want from the list of existing entries.

Make your cells any size by merging XE "merging"  them

If you’ve ever needed to have cells that were different sizes, you’ve probably tried changing the column width, but that only changes the cells horizontally. If you want to change many different cells’ sizes both vertically and horizontally, you’ll want to try merging XE "merging"  the cells. To merge cells, start by selecting the cells that you want to merge. Next, choose Format \ Cells from the menu bar. Then, click the Alignment tab, choose the merge cells checkbox and click OK. If you are attempting to merge two cells that both contain values, you’ll receive a warning message that states that if you merge the two cells, only the data in the upper-left cell will be kept.

Excel Cell Error XE "Error"  Messages 

“ What do those strange Excel cell messages mean - the ones like #NAME or ###### ? “

These errors that start with a hash/pound # symbol appear in a cell when there’s a problem.

When the cell result is too wide for the cell, these symbols appear instead.  To fix, widen the column width.  The easiest way is to double-click on the column heading border between that column and the next - this will force a ‘best-fit’ width.  Or choose Format | Column .

#VALUE! XE "#VALUE!" 
This means there’s an error in your formula - Excel can’t work out a result.  Click on the cell and carefully examine the formula.

#NAME? XE "#NAME?" 
The formula has a range name that Excel can’t find in the worksheet.  Usually it’s a spelling error, or a formula copied from another sheet.

#DIV/0! XE "#DIV/0!" 
The formula includes an attempt to divide by zero - which is mathematically impossible.

#N/A XE "#N/A" 
One of the cells that this formula relies upon is either incomplete, not available or has an error.  Look for other cells with errors, once you fix those #N/A XE "#N/A"  errors will usually disappear.

More on 3D

Here’s how to add more pizzazz to an AutoShape XE "AutoShape" . 

1.
Select your AutoShape XE "AutoShape" . 

2.
On the Draw toolbar, click the 3D button. 

3.
On the palette, click 3D Settings; the 3D Settings toolbar appears. 

4.
Start clicking around. The toolbar lets you tilt your shape and change its perspective and depth—even its surface appearance. 

Showing Excel Running Totals XE "Running Totals"  

“ I have an Excel worksheet with a long list of figures and a total at the bottom. Is there a way to display the total  more prominently so I don’t have to scroll down the bottom all the time? “

Sure, just some creative use of the Freeze Panes XE "Freeze Panes"  feature and SUM command.

Freeze Panes XE "Freeze Panes"  is the way to ‘lock’ the top and left sections of a worksheet so they always appear on the screen. 

Normally you freeze the top row and left column of a worksheet (they have the row/column labels), but there’s no rule to say you can’t freeze the top two rows and use the second row to display your totals.

Assuming the column headings are in the first row, insert the SUM command in the second row. You can’t total the whole column eg =SUM(B:B) if the total is in the same column (you get a circular reference error) so normally you specify the first cell then a cell way past the reasonable lengths of the list eg =SUM(B3:B999) or =SUM(B3:B65536)

Finally some decorative touches to make sure the total stands out (and isn’t confused with) the list of entries.  Use highlight (if available in your version of Excel) or Format | Cells and change the font, border and/or patterns.

Shrink To Fit XE "Shrink To Fit"           

Say you have a label XE "label"  that’s a tad too long to fit into its cell, but for whatever reason you don’t want to increase the column width and you don’t want to wrap the text to a second line. Are you stuck with a truncated label? Only if you want to be. You can have Excel automatically shrink the label to fit into the cell: 

1.
Right-click the problem cell. 

2.
Choose Format Cells from the shortcut menu. 

3.
Click the Alignment tab. 

4.
Select Shrink to Fit. 

5.
Click OK. 

Excel automatically reduces the point size of the text to the largest size that fits within the cell on one line.                       

Excel Dates XE "Dates"  Update          

HELP! When I key in a date such as 02/28/28, Excel enters it as 02/28/2028, when in fact I wanted to enter 02/28/1928. I’ve tried formatting it different ways but nothing seems to work—I always have to key the entire century, all four digits. Is there another way? 

The answer, Bob, is no. When as part of a date you enter only two digits for the year, Excel behaves as follows: 

1. If you enter your year as 00 through 29, Excel assumes you mean the 21st century, or the 2000s. To enter a year from 1900 through 1929, you must type all four digits of the year. 

2. If you enter your year as 30 through 99, Excel assumes you mean the 20th century, or the 1900s. To enter a year from 2030 through 2099, you must type all four digits of the year.

Clone Your Worksheet’s Format        

Often, when I need to add a worksheet to a workbook, I need it to have the identical format as the existing ones. If you choose Insert, Worksheet, the new sheet will have the default format. An easy way to do this is to right-click the Sheet2 tab (as an example), and select Move or Copy. When the Move or Copy dialog box opens, select the check box labeled Make a Copy. Next, choose (move to end) and then click OK to continue. Your new sheet will be named Sheet2(2). To rename it, right-click the tab and choose Rename from the menu. Type in the new name and press Enter to save it. 

Quickly display a data table in a chart XE "chart"  

Excel 97 now makes it possible for you to display a data table in a chart XE "chart" .  Begin by accessing an existing chart or creating a chart using the Chart Wizard. After the chart is created, click on the chart and select the Chart menu from the main menu. Now, click the Chart Options command. When the Chart Options dialog box appears, click the Data Table tab. Finally, click the Show Data Table checkbox and click OK. Now, the data table will appear below the chart.

Another Date Tip

Assume you have an earlier date in cell A1 and a later date in cell B1. To calculate the difference—in days—between the two cells in cell C1, follow these steps: 

1.
Select cell C1. 

2.
Type =N(B1-A1). 

3.
Press Enter. 

The N function converts the results to numbers so you get the number of days (instead of a date) as your difference, and so you can use the difference as a number in other equations. 

Conditional Formatting XE "Conditional Formatting"         

Is there a way to format a cell conditional to the value of another cell? For example, can I get all cells in the range A5 to A10 with values less than that in cell A1 to be red, or whatever format I choose?

Here’s an approach to try. Open a blank Excel worksheet and type a number into cell A1. Now, use the mouse to select cells A5 through A10. With the cells selected, choose Format, Conditional Formatting XE "Conditional Formatting" . 

When the Conditional Formatting XE "Conditional Formatting"  dialog box opens, select (for an example) Less Than. Next, click in the third entry box (on the right side of the dialog box) and click cell A1. Click Format now and choose the type of format you want to apply, setting color, font style, etc.  When finished, click OK. 

Now, enter 10 into cell A1 and then enter numbers in cells A5 through A10. All the cells in the range that are less than 10 will assume your format selection. 

Gray Matter       

“I like to use color to separate parts of some of my worksheets. The problem is that when I print the worksheets on a laser printer, the colors often come out too dark or too light. Is there a way to tell Excel to convert all the colors to shades of gray?” 

Excel doesn’t offer any function that will automatically make the conversion for you. The best solution to your problem is to put together a worksheet that uses a number of different colors. Now, choose File, Print Preview. Since your system is set up to use a black-and-white printer, the preview will display in black and white and look much like the worksheet will look on paper. You can experiment with a variety of colors using this method and make notes of the colors that look best. 

In general, you should stay away from dark, fully saturated colors.  For example, saturated red and blue will both look almost black on a black and white printout.     

Selective Service          

Suppose you have to select a range 13 columns wide by 17 rows tall. If you’re like most Excel users, you accomplish this task by counting columns and rows as you select. And if you’re like most Excel users, you probably lose count as you select and wind up doing it all over again. This is an absolute waste of time, as it turns out, because Excel counts the rows and columns for you as you select. Next time you select a range, do this: 

1. Check the Name box (the box to the left of the Formula Bar), which tells you how many rows and columns you’ve selected so far. For example, when the Name box reads “11R x 12C,” the currently selected range contains 11 rows and 12 columns. 

2. When your selection is larger than one screen, look at your mouse pointer. A little note appears next to the pointer, telling you the size of your selection (using the same notation that appears in the Name box when you select smaller ranges). 

Creating your own formatting style

If you’ve ever wanted to create a formatting style that’s different than any of the currently available styles, you’ll be glad to know that there’s an easy way to do it.  First, select the cell that has the combination of formats that you want to include in the new style. Then, choose Style from the Format menu and in the Style name box, type a name for the new style.  To define and apply the style to the selected cells, click OK. To define the style without applying it, click Add, and then click Close. Also, if no cells have the formats you want for the style, you can specify the formats when you name the style. 

Make It Fit the Cells        

Is there an easy way to get drawings in Excel worksheets to line up perfectly with the cell borders? 

There sure is. Let’s say you want to make a drawing of a rectangle, and you want it to enclose a cell range of 3 by 3. First, you’ll need the Drawing toolbar. If you don’t see it, choose View, Toolbars and select Drawing. 

Now, click the Rectangle button in the Drawing toolbar. Hold down the Alt key and draw the rectangle with the mouse. As you draw the rectangle, its sides will snap to the cell borders.  If you need to move the rectangle to a new location, hold down the Alt key while you make the move and it will snap into position on the cell borders.      

A quick way to format cells in excel.

The default format for an Excel cell is ‘General’ and normally you have to manually select Currency or Percentage format using the Format | Cells menu or toolbar buttons.

But there is a quicker way - Excel looks at what you type in each cell and tries to be smart about the formatting. If you enter a money amount with $ sign, it changes to currency format. Typing a % sign after a number converts it to Percentage format.

Examples:

If you type $34.64 into a cell with General formatting - Excel will convert that to a value of 34.64 with Currency formatting.

Type 25% into a cell with General formatting - that converts to .25 with Percentage formatting.

Put This On One Sheet and That On Another 

Let’s say you want to put the monthly revenues on one worksheet and the quarterly summaries on another worksheet. Excel makes this an easy job. 

Open a new workbook and name two of the worksheets. Right-click the Sheet1 tab and choose Rename. Name the sheet Monthly. Now, right-click the Sheet2 tab and name it Quarterly. 

Now, you can design your new worksheet. On sheet Monthly, place all the monthly information. Move to Quarterly and place all the headings, etc. for the quarterly data. 

Suppose you want to add the contents of cells D5 through F5 on the Monthly sheet to place data in the Quarterly sheet. Go to Quarterly and click the cell where the data is to appear. Type in 

=SUM(Monthly!D5:Monthly!F5) 

and press Enter. This will sum the included cells on the Monthly sheet and place the result in the selected cell on the Quarterly sheet. 

Create a quick reminder by adding a comment XE "comment"  to a cell

If you’ve ever needed to remind yourself what a formula does or to document some value of interest, there’s a quick way to add a reminder to a cell.  You can begin by selecting the cell that contains the value that you want to attach a comment XE "comment"  to. Then, choose Insert \ Comment from the menu bar. A text box that contains your name will appear. You may now type your comment into the text box. You can move the text box to any location by simply dragging it and dropping it. To locate a cell that contains a comment, look in the upper right corner of the cell for a red triangle. To view the comment, simply highlight the cell.

Odd Man Out       

Let’s suppose that you have a workbook that deals with inventory that ships only in pairs and you need to make sure that the numbers match up. Let’s suppose even further that someone takes an order and then types 3 into the Number Ordered cell. Here’s how to make sure that you get the correct number. You can force Excel to display the next highest even or odd number. 

Let’s say that you enter the number of items ordered in cell A5. Go to 

cell C5 (or the cell of your choice) and enter 

=Even (A5) 

Move to cell C6 now, and enter 

=Odd (A5) 

Now, enter 3 into cell A5 and cell C5 will display 4 rather than 3, making the order correct. Cell C6 will display 3. 

Here’s how it works: Even rounds up to the nearest even number, and Odd rounds up to the nearest odd number. To get a better feeling for how these functions act, enter a series of numbers into cell A5 and see how cells A5 and A6 respond. 

One Toolbar You Should Never Be Without          

Excel’s Standard toolbar includes buttons for the most common Excel tasks: creating a new workbook, saving, creating a chart XE "chart" , all the basics. But sometimes the Standard toolbar disappears—meaning you unwittingly removed it from the screen display. How can you get it back? 

Press Ctrl + 7. 

As you may have guessed, this key combination is a toggle. If you press Ctrl + 7 while the Standard toolbar is displayed, you make the Standard toolbar disappear. So be careful. 

AutoFill XE "AutoFill" 
Sometimes after you enter a number, label XE "label" , or formula into an Excel cell, you can’t get over how much you like it. Your immediate thought is to copy the item to more cells. But Excel offers some neat shortcuts for FILLING adjacent cells with this entry. 

To fill cells BELOW the entry with the same entry: 

1.
Select a range that includes the cell containing the entry AND as many cells below the entry as you want to fill. 

2.
Press Ctrl + D. 

To fill cells TO THE RIGHT of the entry with the same entry: 

1.
Select a range that includes the cell containing the entry AND as many cells to the right of the entry as you want to fill. 

2.
Press Ctrl + R. 

Here’s how to fill an entire RANGE with a specific entry. Follow along closely, please: 

1.
Select the range you want to fill. 

2.
Type the entry with which you want to fill the range (the entry appears in the first cell of the range). 

3.
Press Ctrl +Enter. 

Excel fills the entire range with the entry. 

Sum If Correct        

Here’s a technique to make sure that all cells in a column are filled with numbers. 

Let’s suppose that you develop worksheets that require someone to enter relatively long columns of numbers. In such a situation, it’s easy to miss a cell. When this happens, the sum is, of course, incorrect. The problem is that the error may not be noticed immediately. You can handle the problem by using Excel’s CountBlank XE "CountBlank"  function to determine if there are any blank cells in the column. 

To try this method, enter a column of numbers beginning with B1. Let’s say you enter numbers from B1 through B5 for this example. Now, go to cell B7 and enter the following formula. 

=if(countblank(b1:b5)>0,”Blank Cell”,sum(b1:b5)) 

Click Enter. 

Since you have numbers entered into all five cells, you’ll get the sum of those numbers. Now, go to cell B3 and press Delete. Your sum cell will now display 

Blank Cell 

to indicate that a cell was missed. Now, the person entering the numbers will have to check the column and locate the missing entry.      

Quick—unhide XE "unhide" !          

You’ve used the handy shortcuts to hide rows or columns in your worksheet (Ctrl + 9 and Ctrl + 0, respectively). So how do you plan to UNHIDE them? To unhide XE "unhide"  rows quickly: 

1.
Select a range including at least one cell above and one cell below the hidden rows (OR on the worksheet frame, select the headings for the rows above and below the hidden rows). 

2.
Press Shift + Ctrl + 9. 

To unhide XE "unhide"  columns quickly: 

1.
Select a range including at least one cell to the left and one cell to the right of the hidden columns (OR on the worksheet frame, select the headings for the columns to the left and right of the hidden columns). 

2.
Press Shift + Ctrl + 0.                       

Enter numbers with decimal XE "decimal"  places or trailing zeros XE "trailing zeros" 
If you’ve ever wanted to enter many numbers with a fixed number of decimal XE "decimal"  places or large whole numbers with a fixed number of trailing zeros XE "trailing zeros"  (0), you’ll be glad to know that there’s an easy way to do it. Begin by opening the Tools menu and choosing Options. Now, then click the Edit tab and select the Fixed decimal check box. Next, in the Places box, enter the number of digits you want to appear to the right of the decimal point. If you want to include zeros (0) automatically when you enter large whole numbers, specify a negative number to indicate the number of zeros. For example, to have Excel automatically insert 125000 when you enter 125, enter -3 in the Places box. Now, Excel inserts a decimal point at the indicated position or inserts the specified number of zeros. However, data you entered before selecting the Fixed decimal option is not affected. Now, when you finish entering numbers with decimal places or zeros, simply return to the Tool menu, choose Options, click the Edit tab and remove the check in the Fixed decimal check box.

Charting XE "Charting"  By Key 

Excel 97 charts are so thoroughly graphical that you’d probably never even think about selecting chart XE "chart"  items with anything other than the mouse. Too bad—because you can select and modify ANY item in a chart, using nothing other than your trusty keyboard. To select a chart via the keyboard: 

1.
Press Ctrl + G. This opens the Go To dialog box. 

2.
Press Alt + S. This clicks the Special button. 

3.
Press B. This selects Objects. 

4.
Press Enter. This is the same as clicking OK. Excel selects all the objects in the current worksheet. 

5.
If necessary, press Tab until only your chart XE "chart"  is selected. 

Change the text or graphic XE "graphic"  for a hyperlink XE "hyperlink" 
There’s an easy way to edit the text or graphic XE "graphic"  in a hyperlink XE "hyperlink" . Begin by selecting the cell or graphic for the hyperlink. To do so, select a cell that contains a text hyperlink, click a cell next to the hyperlink, and then use the arrow keys to move onto the cell. To select a graphic, hold down the [Ctrl] key and click the graphic. If you just need to change text, you can easily edit the text in the formula bar. If you need to change a graphic, you’ll need to use the Drawing or Picture toolbar. However, if the text is part of a graphic, right-click on the selected graphic, and then choose Edit Text from the shortcut menu. To change the picture for a hyperlink, insert the new picture and make it a hyperlink with the same destination. Then delete the old picture and hyperlink.

Idiot-Proofing Your Worksheets       

When you work with Excel worksheets that you pass along to others, you may want to visually block out cells that require no entry. Doing so will prevent someone from entering data in the wrong cells. 

To make sure nobody enters data in an incorrect adjacent cell, you can block out the surrounding cells. Let’s work with a blank worksheet and suppose that your data needs to go in cell D5. You want to make sure that some people don’t inadvertently enter data in cells C5 or E5. 

Click cell C5 and choose Format, Cells. When the Format Cells dialog box opens, click the Patterns tab. Now, click the arrow at the right side of the Pattern list box to expand the list. Select one of the crosshatch patterns and click OK. Cell C5 will now be blocked out by the crosshatch pattern. Although one could still enter data in the cell, it would be illegible and the crosshatch pattern sends a clear signal that data doesn’t belong in that cell. Repeat the above procedure for all cells that you want to block out.     

Fractions XE "Fractions" 
To use fractions in an Excel worksheet, click the cell that you want to enter a fractional number into and type the fraction, for example: 

  3 7/8 

Press the down arrow and click the cell to select it. You’ll see in the formula bar that the decimal XE "decimal"  value is 3.875. 

If you want Excel to convert a column of decimal XE "decimal"  entries to fractions, select the column and then choose Format, Cells. When the dialog box opens, click the Number tab. Click Fraction to select it and then choose the type of fraction you want (one digit, two digits, etc.).  After you make your selection, click OK to close the dialog box and save your changes.     

Using Excel’s AutoSave XE "AutoSave"  

To get rid of the prompt, choose Tools, Add-ins and click AutoSave XE "AutoSave" . When the AutoSave dialog box opens, deselect the check box labeled Prompt Before Saving and click OK. 

To help AutoSave XE "AutoSave"  a bit, name your workbooks as soon as you start working. This will prevent AutoSave from prompting you for a name the first time it activates.      

Effective Interest Rate XE "Interest Rate" 
There’s a quick way to get the actual yearly interest rate. Use Excel’s EFFECT XE "EFFECT"  function to determine the effective yearly interest rate. 

First, make sure EFFECT XE "EFFECT"  is activated. EFFECT is part of the add-in called Analysis Toolpak XE "Analysis Toolpak" . Choose Tools, Add-Ins. Analysis Toolpak should be in the list. Select its check box and click OK. (See the end of this tip for information about installing Analysis Toolpak). 

Now let’s say that you’re considering a purchase, and the stated interest rate is 7 percent compounded monthly. Go to a cell A1 and choose Format, Cells. When the Format Cells dialog box opens, click the Number tab. From the Category list, select Percentage. Click OK. 

Now, type 

=effect(7.0%,12) 

into cell A1 and press Enter. Excel will display 

7.23% 

This is the actual yearly rate. 

If Analysis Toolpak XE "Analysis Toolpak"  doesn’t appear in your Add-Ins list, you’ll need to install it from the MS Office CD. Close Excel (and any other active programs). Put the CD into the CD-ROM drive and click Start, Settings, Control Panel. Next, double-click Add/Remove Programs, then locate and select Microsoft Office 97 on the list. Now, click Add/Remove to open the MS Office Setup program. Click Add/Remove and then select Excel.  Click Change Option and then select Add-Ins. Click OK to close the Change Option dialog box. Back in the Setup dialog box, click Continue. 

Do A Little Maintenance Before Opening          

It’s morning in America, and you’re ready to open your first Excel file of the day. But in the Open dialog box, you can’t help but notice that you’ve got lots of other Excel files you no longer need. Guess you’ll have to use the Windows Explorer to delete them next time you think about it, right? 

Wrong! You can delete files and do lots of other things to them right in the Excel Open dialog box, as follows: 

1.
Choose File + Open (if you haven’t already). 

2.
Right-click ANY file listed. 

3.
Choose an action from the shortcut menu—Delete, Rename, whatever. 

Creating your own formatting style

If you’ve ever wanted to create a formatting style that’s different than any of the currently available styles, you’ll be glad to know that there’s an easy way to do it. First, select the cell that has the combination of formats that you want to include in the new style. Then, choose Style from the Format menu and in the Style name box, type a name for the new style.  To define and apply the style to the selected cells, click OK. To define the style without applying it, click Add, and then click Close. Also, if no cells have the formats you want for the style, you can specify the formats when you name the style. 
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